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1. Overview

EUSurvey is the official online survey management tool of the European Commission. Its development
was started in 2013 under the supervision of DIGIT (http://ec.europa.eu/dgs/informatics/index_en.htm)
and is published as open source software under the terms of the EUPL public license on JOINUP at
https://joinup.ec.europa.eu/software/eusurvey/home. EUSurvey is a servlet based application and can
be installed on any system that runs a JAVA servlet-container.

The system’s development and reference installation runs Apache Tomcat as the servlet container and
uses a MySQL database to store its information. The build process is assisted by Maven for resolving
external dependencies.

This document describes the steps that are necessary to compile and install the open source version of
EUSurvey. Even though the application can be installed on an arbitrary system running JAVA, the
installation of the development environment will be presented on a Microsoft Windows 7 system
representatively, for the sake of simplicity.

Except for Microsoft Windows, all tools used in this tutorial are available free of charge on the
corresponding web sites.

Please notice that EUSurvey can be configured to run on a large number of different environments. In
this case however, the installation of a different set of tools is necessary. The aim of this document is to
guide the interested user through the process of installing a development environment and to deploy a
working instance of the EUSurvey system, with as less effort as possible.

The experienced developer should feel free to use a compatible set of tools of his choice.

2. Prerequisites

To run the application from your own server being connected to the internet, a specific software
architecture, composed of a servlet container and a supported database must be installed. The following
table show an overview of the necessary software packages that should be installed to run (and
compile) the EUSurvey application.

Package Version Download from

JavaSDK  8ul01 http://www.oracle.com/technetwork/java/javase/downloads/index.html

Tomcat 8.0.15 http://tomcat.apache.org/download-80.cgi

1
2
3 MySQL 5.6.21 http://dev.mysql.com/downloads/mysql/
4 Spring 3.6.2 http://spring.io/tools/sts/all

Please notice that installing a software on your computer might require administration privileges. As the
host system is usually shipped with an internet browser and the possibility to unpack zip-compressed
files, these tools will not be mentioned explicitly.
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Tools
The following tools and binaries need to be installed on the system to create and run the application:

Java SDK

Java is the programming language of the EUSurvey system. To run an application in JAVA, regardless
what application it is, the JAVA runtime environment must be installed on your system. Given that we
will create the application from its source-code, the Java Development Kit (JDK) is required.

Download and install the latest JDK 8 version for your system (jdk-8u101) from the Oracle web site:

http://www.oracle.com/technetwork/java/javase/downloads/index.html

Once you have installed it, please conduct the following steps to configure your system:

Adjust system variables
To complete your installation of the JDK on your system, different system variables need to be adjusted
to match your environment.

To do so, please open the System menu from the Control Panel of your system and select “Change
Settings” from the section representing “Computer name, domain, and workgroup settings”.

Contrel Panel Home "
View basic information about your computer
W Device Manager Windows edition
% Remote settings Windows 7 Emerprise
% System protecten Copyright © 2009 Microsoft Corperation. All rights resarved.
% Advenced systemn settings Service Pack
Syatemn
Manufacturer: £C - DIGIT
Mcdet DIGIT A2 RC Chent 7.1,10.0 RTM
Rateg ystern ratng s oot available
Processor Itel(R) Xeon(R) CPU £5-26300 © 2.30GH: e
230 GMz (2 processors)
Iratalled memeory (RAME 400 GB
Systern type 6402 Operating Systern
Pen and Touch No Pen or Towch Ingut & svailable for this
Action Center Dvsplay
] 3 U
Pidoses Vpdete Computer name, demain, and wotkgroup settings -
Perdommance Information and 0 = -
Yook Computer name VW-A3-CRCA-EUsurveyOSS
Full compatter mame: VW-A3-CRCA-EUsunveyOSSmet] ceceuin |

Figure 1 - Change system settings.


http://www.oracle.com/technetwork/java/javase/downloads/index.html

Systern Properties @

Computer Mame | Hardware | Advanced SystemF‘rotectioanemote|

You must be logged on ag an Administrator to make mozt of these changes.

Performance
Vizual effects, processor scheduling, memary usage, and virual memanyg

Settings
User Profiles

Desktop settings related to pour logon
Startup and Recovery

Systern startup, system Failure, and debugging information

Settings...

Settings.
Environment ¥ ariables...

[ ak ][ Cancel ] Apply

Figure 2 - Edit environment variables.

Environment Variables u

User variables for stem

ariable Value

TEMP %LISERPROFILE®%\AppData'Local Temp

TMP ISERPROFILE%:\AppDataLocalTemp
New.. || Edt.. || Delete

System variables

Variable Value

C:\ProgramData\Orade\Java\javapath;...
PATHENT .COM;.EXE;.BAT;.CMD; .VBS; . VBE;. I5;.....

PROCESSOR_A... AMD&4
PROCESSOR_ID... Intels4 Family & Model 45 Stepping 7, G... ™

New.. || Edt. || Delete |

[ ok || cancel

Figure 3 - Edit system variables.



JAVA_HOME
Edit or create a new variable named JAVA_HOME and assign it the path to the installation directory of
your JDK installation. (e.g. c:\jdk)

PATH
Additionally, add the patch containing the Java binaries of your JDK installation to the variable named
PATH (e.g. c:\jdk\bin)

To test your installation, please open a windows command prompt and type “java -version”. Type in
“cmd” in the search field of your Start-environment and execute “cmd.exe” from the result list.

" '\

Programs (1)

I BN crmd.exe I

- See more results

|cmd| P [ Logoff | |

.'ff"

- .
o, 1.

d’ ;

On successful installation, java will return information about the installed version.

BN Coindowshsystern32omd.exe E@

Microsoft Windows [Uersion 6.1.76H11 -
Copyright <c> 2808? Microsoft Corporation. All rights reserved.

C:wlserssstem>java —version

java version '1.8.68_28"

Java(TM>» SE Runtime Environment Chuild 1.8.60_20-h26>
Java HotSpot<TH> Client UM <huild 25.28-bh23. mixed mode?

C:wUzerssstem>

To install the MySQL database server, download the latest MySQL Community Server of version5.6 from
the MySQL web site:



http://dev.mysql.com/downloads/mysql/

The Installation Guide is based on version 4.5.11.0 of the MySQL Database. It might be possible newer
versions of the product are shipped with a slightly different installation wizard.

Hint

Please notice that the installation of the MySQL database requires the .NET framework 4.0 to be
installed on your computer. If the wizard cannot find this package on your computer, the installation
process will stop, showing you the message below. In this case, please browse to the indicated URL to
download and install your copy of the Microsoft .NET Framework 4.5 binaries before proceeding.

MySQL Installer | 2|

Thiz applcation requires \MET Framework 4.0, Pleaze
l % inztall the MET Framewark then rin thiz installer again.

For more information, please see

http: & o microzaft. cormdfslink A Linkl d=18101 2

Figure 6 - Error message mentioning .NET to be required

From the Oracle web-page, please download the MySQL Community server. Choose the Windows (x86,
64 bit), MySQL Installer MSI that contains an offline-installation wizard, that will guide you through the
installation process.

Recommended Download:

MySQL Installer 5.6

for Windows n.
All MySQL Products. For All Windows Platforms. "
In One Package.

Windows (x86, 64-bit), MySQL Installer MSI m

Figure 7 - Download MySQL from the Oracle web-page

Please make sure to download the full installation package and not the web-installer package, as
depicted in the screenshot below.


http://dev.mysql.com/downloads/mysql/

Windows (x86, 32-bit), MSI Installer 5.6.21 1.4M Download

{mysgl-installer-web-community-5.6.21.1.msi) MD5: afcc3a7eziesf2cc3er1az7cefaazrdd | Signature
Windows (x86, 32-bit), MSI Installer 5.6.21 287.0M Download
{mysgl-installer-community-5.6.21.1.msi) MD5: £2ee386390671b410b0924564a3d5496 | Signature

Figure 8 - Download full offline installer package.

Once you have launched the installation wizard, please select the “Custom” type of installation and
adapt the installation- and data-path.

A Choosin
2 g a Setup Type
MySQL. Installer

Please select the Setup Type that suits your use case.

© Developer Default 5'=‘Ilb"p Type DESTipﬁon e
Allows you to select exactly which products you
Iﬂ?s;auf da" prloduds tneeded for would like to install. This also allows to pick other
¥5QL development purposes. server versions and architectures (depending on
your Q3).
© Server only
Setup Type
Installs only the MySQL Server
product.

@ Client only
Installs only the MySQL Client
products, without a server,

@ Full Installation Path: B~
Installs all included MySQL products [C:\Program Files\MySQL\ | E]
and features,

|:§:| Custom Data Path: e
Manually select the products that [C: ProgramData\MySQLMySQL Server 5.6\ | E]
should be installed an the system,

< Back l ’ Next = l [ Cancel

Figure 9 - Select "Custom" installation type.

When coming to “Feature Selection”, make sure that “MySQL Workbench CE” is selected. This
application represents an easy-to-use MySQL client application. Please notice that such an application



will be necessary at a later point of the installation process, to create a custom database schema for
EUSurvey manually.

Hint

The installation of this application requires the Microsoft Visual C++ runtime libraries. These libraries are
installed automatically by the wizard during the installation process, if not already existing on your
system.

t\a Feature Selection
MySQL. Installer

Please select the products and features you would like to install on this machine.

. Product Catalog: Architecture:
% MySQL 5.6 Community Edition - |64-Bit -
| MysqQL Server 5.6.11 el Y MySQL Workbench CE

¥5QL server s‘.?.\ The MyS0L GUI Developer tool (Community B

Applications S| MySQL Workbench Core

Program Shortcut
Feature Selection

MySQL Warkbench CE 5.2.47

MySQL Notifier 1.0.3

MySQL For Excel 1.1.1

E MySQL Connectors

I_Jll-"-ln e M .

Estimated T

< Back ] ’ Mext = l [ Cancel

Figure 10 - Select MySQL Workbench for installation.

Please feel free to unselect different other options, as they are not necessary for a successful installation
of the EUSurvey system.

Once you have successfully installed the MySQL server and client on your computer, an initial
configuration becomes necessary. On the second page of the configuration phase, please set the
password of the MySQL root account.



Y\{ MySQL Server Configuration 2/3
MySQL. Installer

Root Account Password

Enter the password for the root account. Please remember to store
this password in & secure place.
[ root]

MySQL Root Password: #sesssssssssnss

Repeat Password: ..............l

Password Strength: Strong

MySQL User Accounts

s Create MySQL user accounts for your users and applications.
' Assign a role to the user that consists of a set of privileges.
Dy

MySQL Username  Host Iser Role Add User

Edit Uiser

Configuration

< Back l [ Mext = ] ’ Cancel

Figure 11 - Setting a new MySQL root-password.

Once you have done so, please follow the wizard until a successful installation is reported by the system.

Enabling Event-Scheduler
EUSurvey makes use of an advanced database functionality named “Event Scheduler”. Unfortunately,
this feature is not enabled by default, but has to be enabled before EUSurvey can make use of it.

To do so, please edit the configuration file of your MySQL server “my.ini” or “my.cnf”, usually located in
the server’s sub-folder under the “ProgramData” folder of your system disk.

Troubleshoot

If you don't find the ProgramData or the my.ini file, please change your explorer settings to display
hidden and system folder/files.

10



@-\;}vl v Computer » Local Disk (C:) » ProgramData » MySQL » MySQL Server 56 »

Organize v j Open = Print Mew folder

i Mame Date modified Type Size
el Libraries data 190820040845 File folder
J_u Doctjlments & | my.ni 18.08,2014 13:16 Configuration sett.., 14 KB
i‘ z’:::::es £ rmy_2014-08-18T12-50- 23, ZLOLIL4 1442 Configuration sett. 14KE
B videos

Figure 12 - Edit database configuration file from MySQL installation directory.

In this file, please scroll down to the [mysqld] section of the file and add the following line to it:

“event-scheduler=ON”

Example

F
# server_type=3
[mysqgld]

event-scheduler=on <:

# The next three options are mutually exclusive to SERVER_PORT helow.
# skip-networking

# enaE1e—named—p1pe

# Thae Pine the mvEn Server will n=sa

Figure 13 - Add event-scheduler switch to MySQL configuration.

To take these settings into account the database (that has already been started right after installation
and is running as a background service) needs to be restarted.

Therefore, please open the view on system Services and RESTART the system service labelled
“MySQL56” as described in the Knowledge section below.
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L Services EI@

File  Action  View Help

= @B E ez HE > = 0w

G Services (Local) " Services {Localy

MySQLSG Marme = Description Status Startup Type Log On &5 b
S IP Helper Provides tu,.,  Started Autamatic Local Syste,.,

Stop the sen.ric.e SIPsec Policy Agent Internet Pro..  Started Manual Metwork 5.

Pause the service

@the semvice o KtmRm for Distributed Tran..,  Coordinates... Manual Metwork 5.
S Link-Layer Topology Discov.,  Creates a M. Manual Local Service
S Media Center Extender Service Allows Med.. Disabled Local Service
S Microsoft MET Framewvork ... Microsoft... Disabled Local Syste...
S Microsoft [NET Frarmewark .. Microsoft ... Disabled Local Syste,., =
S Microsoft MET Framewvork ... Microsoft... Autornatic (0., Local Syste..
S Microsoft [NET Framewark .. Microsoft.., Automatic (0, Local Syste,,
S Microsoft iSCSlInitiator Sere., Manages In.. tanual Local Syste...
S Microsoft Software Shadow .. Manages sou. Manual Local Syste..,

S Multirmedia Class Scheduler  Enables rela,., Autamatic Local Syste,.,

* 31y A o
=M Start Receives act.., Dizabled Metavark ..
Sl Stop Receives act., Disabled Local Service
e e Receives act.., Dizabled Local Service
el Provides abi... Disabled Local Service
Resume L .
SaN Maintains a .. Started Autamatic Local Syste,.,
Sl e <: The Metwar... Manual Metwork 5.
e 2l Tasks » | Manageso.,  Started Manual Local Syste,.,
M Identifies th.,  Started Manual Local Service o
\ Extended /(Standard/ Refresh
Stop and Start service MySQL56 on Local Computer Properties
Help

Figure 14 - Restart the MySQL service after configuration.

Once you have successfully performed all above mentioned steps you are ready to build EUSurvey from
its sources and to deploy the application to the servlet container (e.g. Apache Tomcat).

Apache Tomcat Servlet Container

As a Java web application, EUSurvey requires an application server (more precisely, a Servlet Container)
to run the application. Such a servlet container is offered from different manufacturers and can be used
interchangeably. In the context of this installation guide, the deployment on an Apache Tomcat servlet
container will be described exemplarily for this type of application.

Please download and install the latest Apache Tomcat version from the Apache web site located at:

http://tomcat.apache.org/download-80.cgi

Make sure to download the 32-bit/64bit Windows Service Installer from the download page. It contains
an installation wizard that will guide you through the installation process.

From the installation wizard, please select the custom type of installation and set the “Service Startup”
as shown in the screenshot below.

12



(20 Apache Tomeat Setup fod @ |
(Ohoose Components
Choone winch faatires of Apache Tomeat you mant to netal. >
Check the components you want to Pstal and unchedk e components you don't want %
instal. Ohck Next to contrue,
Select the type of rstall: -
O, select the cponsl Oumcpten
components you wish fo
natal: >
[¥] Start Mer Trems
[¥] Docmentaton
Space required: 11.6V8 m‘ nage
<tok [ nem> ] [ coce

Figure 15 - Select application to run as a service

During the installation process, please specify the folder where you have installed your Java Runtime
Environment (JRE), as done in the previous step.

rE.ﬁ.pm:he Tarneat Setup: Java Virtusl Machine path selection =@ E
Jawa Virtwal Machane 3
Jarva Virtuad Muachine path selection. B

Plearsey sebect tro path of & Java SE 6.0 o later JRE instabed on your sysbem,

i Program Fies (x86) Javalre? s

<Back || Mest> [ cancal

Figure 16 - Specify JRE location.

After successful installation, the Servlet Container that runs as a System Service needs to be started.
This step is mandatory for the web-application to be correctly deployed.

To do so, please open the view on system services and select “Start” from the respective service entry
labelled “Apache Tomcat 7.0 Tomcat 7” from your item’s context menu.

Please read the section on how to “Control System Services”, if you are unsure on how to do this.

13



. Services
File Action View Help

s [@Eod=zH=l>»anw

oo E=s

S Services (Local) . Senvices (Local)
Apathe Tomcat 7.0 Tomcat? Mame ° Description Status  Stertup Type
O ActiveX Tnstaller (AdnstS) Provides User Account Control walidstion for the installation of ActiveX con.. Wanual
Sortthe service Adaptive Brightness Wanitars ambient light sensors ta detect changes in ambient light and adju.. Manual
N —— Wanusl
Description: Lo Application Experience Start <: ion compatibility cache requests for applications as they .. Manual
Apache Tomeat 7,055 Server - o5, Application Tdentity Stop Hifies the identity of an application. Disabling this service ... Manual
ittpif/tomeatapache org/ %, Application Information Pause hing of interactive applications with additional administra., Startsd  Manual
% Application Layer Gateway Servi Resume lor 3rd party protecal plug-ins for Intemet Connection Sh.. Manual
£ Application Management s jon, removal, and enumeration requests for software depl. Manual
£ ASP.MET State Service lor out-af-proce s session states for ASE.MET, If this servic.. Disabled
o Background Intelligent Transfer All Tasks ¥ e background using idle netwark bandwidth, If the servic.. Wanual
I Base Filtering Engine Engine (BFE) is a service that manages firewall and Intem... ~ Started  Automatic
2 BitLacker Drive Encryption Servi il BitLocker Drive Encryption service, BitLacker Drive Encryp... Manual
%, Black Level Backup Engine Servi Propertes rvice is used by Windows Backup to perform backup and .. Manual
£ Bluetoath Support Service bice supports discovery and association of remate Blueta .. Wanual
& BranchCache Help s netwiork content frarm peers on the local subnet. Manual

Lag On &s
Local Syste..
Lacal Service

Local Syste..
Lacal Service

Local Syste..
Lacal Service
Lacal Syste..
Network ...
Local Syste..
Local Service
Lacal Syste..
Lacal Syste..
Local Senvice
Network ...

Figure 17 - Start Tomcat from the System Services view.

Once Apache Tomcat has been started successfully, please browse to the following URL.

http://localhost:8080/

Once your Servlet Container has been installed and started successfully, your browser will show the

following (or similar) page:

Sip Favorites

[#] Apache Tormcaty/7.0.55

& Apache Tomeat/7.0.55 - Windows Internet Explorer E=nE=R ===
@Uv [B httpistocathostansny - &4 | x || sing 2 -]
1:.5 B Suggested Sites v @] Web Slice Gallery =
oo~ v [ geh v Pagew Safetyw Toolsv @~

Home Decumentation Configuration Examples Wiki

Apache Tomcat/7.0.55

™

&

Recommended Reading:
Considerations HOW-TO

Manager Application HOW-TO
Clustering/Session Replication HOW-TO

Securi

Mailing Lists Find Help

Wpache Software Foundation
& http://www.apache.org/

Senver Status
Manager App

Host Manager

m

Figure 18 - Apache Tomcat welcome screen.

Spring Tool Suite

EUSurvey was built on top of a software framework named Spring MVC. To start your work on EUSurvey,
we propose to use the Sprint Tool Suite as the primary IDE.

The Spring Tool Suite (STS) is a Java IDE based on the popular Java IDE “Eclipse” and has the binaries of
the Spring framework built-in, as well as different other tools that facilitate development on the Spring

MVC framework.

Download and extract the latest Spring Tool Suite version from the Spring web-site located at:

14



http://localhost:8080/

http://spring.io/tools/sts/all

Please make sure the package you install match your installation of the JDK (in terms of being compiled
for 32 or 64bit architectures).

SPRING TOOL SUITE”
Windows Mac Linux
Based on Eclipse 4.4.1 Basad on Eclipse 4.4.1 Basad on Edlipse 4.4.1

STS 3.6.2.RELEASE

WiN, 32BIT WiIN, 54 BIT

Figure 19 - Select 32 or 64bit release from the STS-download-page, depending on what JDK binaries have been installed.

Once the Sprint Tool Suite has been extracted to a local directory, the IDE can be started by executing
“sts.exe” from the root-directory of the software package.

Troubleshoot

In case an error is telling you "Failed to load JNI shared library", the Sprint Tool Suite you have
downloaded does not match your installation of your JDK (in terms of being compiled for 32 or 64bit
system).

In this case, please download the package matching your JDK installation.

As soon as above mentioned prerequisites are fulfilled, please proceed to the creation of the new
EUSurvey database and to the deployment of the application from the compiled sources.

Maven
To avoid any problem with the compilation from any IDE (sts,eclipse,...) we have to install the maven
software in order to create the war file.

Download and extract the Maven 3.2.3 (minimum required) from this link
http://maven.apache.org/download.cgi# and choose the Binary file

Extract the zip file to a folder

Adjust system variables
To complete your installation of the maven on your system, different system variables need to be
adjusted to match your environment.

To do so, please open the System menu from the Control Panel of your system and select “Change
Settings” from the section representing “Computer name, domain, and workgroup settings”.

15
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Cortrel Panel Home

% Device Manager

% Remote settings

% Systemn protection

¥ Advenced systemn settings

Action Center
Windows Update

Perdormance Information and
Took

View basic information about your computer

Windows edition
Windows 7 Enterprise
Copynght © 2009 Microsoft Corporaticon. All rights reserved.
Service Pack 1

System
Manufacturer: £C - DGIT
Mcdet DIGIT A2 RC Chient 7.1.10.0 RTM
Rateg: Systemn ratng i oot avalable n
Precessor: Jrel(R) Xeon(R) CPU £5. 26300 @ 2.30GH: Cranten

2.30 GMz (2 processors)
Iratalled memery (RAME 400 G8

Systenn hype 642 Operating Systemn
Pen and Touch: No Pen or Touch Ingat & svailable for this
Dwsplay

Competer name, demain, and workgroup settings
Computer name: VW-A3-CRCA-EUsurveyOSS
Full companter mame: VW-A3-CRCA-EUsurveyOSSmet] ceceuint

Figure 20 - Change system settings.

Systern Properties @

Computer Mame | Hardware | Advanced SystemF'rotectioanemote|

*Y'ou must be logged on az an Administrator to make most of theze changes.

Perfarmance

Wizual effects, processor scheduling, memary usage, and wvirtual memory

Uszer Profiles

Desktop zettings related to your logon

Startup and Recaovery

Sustem startup, system failure, and debugging information

Environment % ariables...

QK ][ Cancel ] Apply
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Envircnment Variables

User variables for duyckje

Variable Value

EC_COMPUTER... DIGIT

EC_HOMEAPFD... H:\_CI_APPDATA

EC_USER_DEPA... DIGIT.A.3.001

EC_USER_DG DIGIT T

[ mew.. || Edit. || Delete

System variables

Variable Value e
M2 %M2_HOME%\bin
M2_HOME C:Yjod\apache-maven-3.2.3)

NUMBER_OF_P... 2
ORACLE_BASE Ci\jgd\orade\apptorace\productilt.20

[ mew.. || Edit. || bDelete |

| OK | | Cancel |

M2 and M2_HOME variables
Edit or create a new variable named M2_HOME and assign it the path to the installation directory of
your maven installation.

Edit or create a new variable named M2 and assign it the value %M2_HOME%\bin

PATH variable
Edit the Path variable by adding the %M2% entry

To ensure the proper installation of the Maven tools, open a command prompt windows and type mvn —
version, you should have this kind of value returned

B Clwindows\system32\cmd.exe

Microsoft Windows [Uersion 6.1.766811
Copyright <c> 288% Microsoft Corporation. HAll rights reserved.

C:sUzerssduyckje*mun —version
fipache Maven 3.2.3 (33fB8c3el1B27c3ddde?9d3cdebad2656a3ledfdf4; 2014-088-11T22:58:10+02:-004>
Maven home: C:sjgdsapache-—maven—3.2.3

Java version: 1.7.8_71. vendor: QOracle Corporation

Java home: C:isjgdsjavasjre

Default locale: en_GB. platform encoding: Cpl252

0% name: "windows 7", wversion: "6.1", arch: "amdb64". family: "windows"
C:sUserssduyckje >

If you want to use an automatic translation tool that is partially free* (see on the website the limitation
of the free version), please follow those instructions

Go to the url https://datamarket.azure.com/dataset/bing/microsofttranslator
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https://datamarket.azure.com/dataset/bing/microsofttranslator

Microsoft Azure
Ma rketp|ace Learn Applications Data My Account Publish
Heme * Data * Microsoft Translator
Microsoft Translator 2,000,000 £0.00
Charactersimonth
_________________ per month
53‘) Data LS
Published by: Microsoft Translator 4,000,000 £26.36
Categories: Communications, Machine Learning, Reference, Ehatad Aoy per month
Developer Services, High Tech & Elecronics [ Buv
Date added 3108201
) 6,000,000 £39.54
Get support for this offering Charsciershrionin per month
Microsoft Translator is a WEB AP that enables Automatic Translation (Machine
Translation) of text between any of the 50 supported languages This state-
ofthe-art statistical machine translation AP powers billions of translations Eﬁggcgr’gn%?th %g?m:{f
every day. It also provides additional functionality such as language detection ~ ~ 77777 “
and pre- and post-editing customization with, respectively, the Translator Hub
and Collaborative Translation Framework (CTF),
The APl is used in the translation features of many Microsoft products, such as gg;?mgg;}nq%? £1£ﬂi'ﬂ‘:13
Office, SharePoint, Lync, Yammer, Visual Studio, and Bing. It also powers ~ ~7777777770TT p“
numerous consumer translation apps. For quick and easy website translations,
customers can integrate to their site, blog, or SharePoint site, the Translator 32 000 000 £201.60
Web Widget Charactersimonth per month
To get started using the Translator API, gote TS “
www MicrosofiTranslator.com/GetStarte d
. 64,000,000 £387.07
Chatacters/menth per month

Please follow the instructions given by the website

But in summary you need first to create an account.

Search for the Translator application

Microsoft Azure
Ma rketp|ace Learn Applications Data My Account Publish

Heme * Search: Translator

type Areunsi
APPLICATIONS 3)

Sort By: _ MName Publisher
DATA (1] v -
rice :

p Microsoft Translator data
FREE () r% published by: Microsoft Translator .
PAID (1) @su bscribed

a ! Microsoft Translator delivers Automatic Translation (Machine Translation)
CATALOG 3) of a text into a specified language. It is a state-of-the-art statistical
machine translation system translating between any of the supported
category languages.
AUTOMOTIVE, INDUSTRIAL, &
AEROSPACE [1) .
BUSINESS AND FINANCE (2 Vfan Micro Translate application

and sign up for the version that you need (first option is free 2.000.000 character translated / month)
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Microsoft Azure
Ma rketp|ace Learn Applications Data My Account Publish

Home > Data > Microsoft Translator

Microsoft Translator (TR T
d Data 2,000,000 D00€
Characters/month per month
CANCEL
Published by WMicrosoft Translator
Categories Communications, Machine Leaming, Reference, 4,000,000 31,80€
Developer Services, High Tech & Electronics Characters/month per month
Date added 21-08-11
Get support for this offering
6,000,000 4771¢€

Charactersimont per montn

Wicrosoft Translator is a WEB APl that enables Automatic Translation (Machine
Transiation) of text between any of the 50 supponted lanquages. This state-

After Sign-Up you need to register the application, to do that from at the end of the page you have the
Register your application below the Develop section

Microsoft Azure |

Marketp|ace Learn Applications Data My Account Publish i

One-Stop Shop for Premium Data and Appl

Hundreds of Apps, Thousands of Subscriptions, Trillions of Data Point:

Need more than you

subscribed for? No waorries.
We can now Auto Refill

your subscription with

zero downtime.

« ; digital

Statys

Activg
2,000 T,
Témaining S actions
Refilig Avaiiablg o
Enable ayg g

Use
Show Termg

Cancay

Microsoft Azure

i Marketplace

000,000
*Maining Transactions

applications data ann

National Accounts

True False &
WebUpload tr Official Country Data
Webuplﬂad True False WebUpload s{ a a - United Nations Sta
is a professional, The database contains
scalable, easy-to-use detailed official
document storage solution for national accounts statistics in
compa.. national currencies as pr..
MyGet - Packag:d Power Data
- mal ement made
This catalog contains a
k’ met ?:3 dOtl—oQC series of reference data
MyGet allows you to sets designed as star
create and host your schema dimension
own MuGet feed. Include packages tables fo..
frem the official MuGet...
o ILO Data -
scientiam™bile 'WURFL Cloud Service ] International Labour
=, The WURFL Cloud 4 U N a a Organization
Service is a highly- - « A world of informat The International
available mohile Labour Organization
wurfl device detection rovides Uhdata with 2 products: 1.
service. Thanks to a simple... EA BORSTA, which has...

ACCOUNT PUBLISH DEVELOP
Publishing Porta

HOME

5

amples

Register Your Application

Enter the data that you need



Microsoft Azure E
Ma rketplace Learn Applications Data My Account Publish 2

Register your application

Client ID my_translator_client_id

Your application's ID. It can be a mix of numbers, letters, hyphens and underscores,

Name Translator_client

The name of the application that will be displayed to the user when asking the user's permission to access their account.

Client secret N

Password for your application, Keep it secret. You man provide your own, or use the provided one above,

Redirect URI https://Microsoftcom

URL to redirect at the end of the consent flow. Clients that don't use the consent flow (e.g. Microsoft Translator) should
enter any valid URL.

[T Enable subdomain access

Enables subdomains for the redirect URI to be specified when invoking the consent flow. In most scenarios, this should
remain unchecked.

Description Translator Tes{

Optienal description for the application, visible only to you.

CREATE

« Cancel

You have to remember the Client ID value and the Client Secret that must be set in the spring.properties
file (see Configure the application)

Knowledge

To be able to work on an EUSurvey development environment, the following advanced system
knowledge is necessary:

e Modifying the state of existing System Services.

Control System Services
At different moments of the installation, you will have to start/stop/restart background tasks of your
system, called Services.

In Windows systems, Services are controlled from a specific view named “Services” that is accessible
from the Control Panel of your system or right from the Start Menu of your system.

To open this view, you can type “Services” into the input field in the start menu and activate the
respective element.
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Programs (3)

| Lo Services

o : - . .
Companent Ser\{ Starts, stops, and configures Windows services, ]

B services.exe

Control Panel (&)

Ty
= see mare results

| services]

| Logoff

|+

Figure 21 — Show System Services.

To modify a Service’s stage, select an entry and click the right mouse button to open the context menu
of the respective Service.

Then, please select “Start”, “Stop” or “Restart” to change the Service’s state.

o Services

File  Action

L

Yiewr  Help
NERCREN 7 Bosl LA N

L. Services (Lacaly

_';;‘ Services (Local)

MySQL56

Stop the service
Pause the service
Restart the service

Marne

S IP Helper

S IPsec Policy Agent

S KB for Distributed Tran..,

S Link-Layer Topology Discow..
Lo Media Center Bxtender Service
S Microsoft MET Framework ..

S Microsoft MET Framewark ..

S Microsoft MET Framework ..

S Microsoft MET Framewark .

Lo Microsoft iSCSL Initiator Sen.,
Lo Microsoft Software Shadow ..,
S Multirmedia Class Scheduler

Description

Provides tu...
Internet Pro...
Coordinates..,
Creates a M.
Allows Med...
Microsoft ...
Microsoft ...
Microsoft ...
Microsoft ..
Manages In..,
Fanages sou.
Enables rela..

Receives act..,
Receives act.,
Receives act..,
Provides abi..,
Maintains a ...
The Metwar...
Manages o..
Identifies th...

Status

Started
Started

Started

Started
Started

Startup Type
Autornatic
Manual
Manual
Manual
Disabled
Disabled
Disabled

Automatic (0.
Automatic (D,

tanual
Manual
Autornatic

& tomatic
Disabled
Disabled
Disabled
Disabled

Autornatic

Manual
Manual

Manual

Log On &5

Local Syste,.,
Metwork 5.
Metwork 5.
Local Service
Local Service
Local Syste...
Local Syste,.,
Local Syste...
Local Syste..,
Local Syste...
Local Syste..,
Local Syste,.,

Metwork 5.
Local Service
Local Service
Local Service
Local Syste,.,
Metwork 5.
Local Syste,.,
Local Service

——

Extended AStandard /

Stop and Start service MySQL56 on Local Computer

3 6

S Start

S Stop

e Pause

',"(" Resurne

i

o) Restart <:

S Al Tasks ’
Refresh
Properties
Help

Figure 22- Changing a service's state.
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Warning

Please make sure not to unintentionally stop services that are not described in this document, given that
this may affect the stability of your system.

3. Initialize the Database
After having installed the necessary software packages, a new database must be created and
configured. This will require the following 3 steps to be conducted:

1. Creation of a new database schema for EUSurvey
2. Creation of a new database user to be used with EUSurvey
3. Customizing the database server.

Create a new schema

To create a new schema, open the MySQL Workbench and connect yourself to the database server you
have installed in a previous step selecting “Database -> Connect to Database...” from the application’s
menu.

Use the root user and the password you have specified during the installation.

Once connected to the database server, select “Create a new schema in the connected server” to create
a new database for EUSurvey by clicking the respective icon from the toolbar.

A new page will be shown, offering the possibility to configure your new schema. Please call your new
schema “eusurvey” and select “utf8- default collation” as collation of choice.

Flo E&

Query Database Plions  Scipting  Help

SCHEMAS o The narw of the schama, Tt & recommended 10 ute only dphacumen

4o charactens. Spaces thould be avoided and be mplaced by _

leg vey I
sabda - cm:l G - dof audk colakion v I Spechies which dumetioolations the wchama'’s tables wil we  thay do eax

: test have an aiphor setting. Comeon dhoices are Lating o UTF3,
» world

Figure 23 - Name the new database and select a collation.

Once you have done so, please click “Apply” to create your new schema. On success, a new schema will
appear in the object browser.

SCHEMAS . :
Q, Filter objects

BUSUPEY -{::

sakila
kesk
warld

y¥yYwvy

Figure 24 - New schema shown in object browser.
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Create a new DB user

Once you have successfully created a new DB to save the elements created by EUSurvey, a new
database user will have to be created, that can be used by the application to read and write into it.

To do so, please select “Users and Privileges” from the “Management” menu section of your Workbench
and click the button labelled “Add Account”, located at the bottom of the screen.

B st Wk ek

AR TR T
O ierver Statuz
1 ohera Conneomarg
B imiers wna Prasie g
BS Shabun wnd Tyfem Viarieblep
& Db Bsgeaet
&, Doks ImpoetRurtan
BSTANCE N
B s ¢ Shaungoen

J:L Sarvarlag:

& Cphosa Fig

Ry
sy
(=)

TrYyww D

L AR A

ot
M@ T 00T W

Be £ Viw Doy Diibes Gwe Duk Sovep b
ol el ol&1&E16] 8 -

Adewruibabon - Usei ol Fd

i Users and Privileges

Lkier St

(L)
(1) sanomywas >
it
ok
ok

A ool

Froes bt Lo fuccrant Limds | dkdmarste stive Bkt | Schesea Procieges:

Rttt
1270001

RS Paeeord

(ke

® D0
I

Figure 25 - Adding a new database user.

If you are asked to re-enter the password of user “root”, please do so.

Once you have clicked “Add Account”, the system will ask you to give the new user a name and to assign
him respective privileges to perform specific tasks on your newly created database schema.

At first, please name your new user “eusurveyuser” on the “Login” tab. Then, choose and confirm a new
password for this new user.



i Users and Privileges

User Accounts

Details for account eusurveyuser@localhost

Lser Fram Hosk
(1} <anonymous = Yo
el et localhost:
rook localhost
rook 127.0.0.1
roak; i

Login | Account Limits | &dministrative Roles I Schema Privileges

Login Marne:

Authentication Type:

Lirnit Connectivity to Hosts Matching:

Password:

Confirm Password:

eUsUrYeyuser

‘ol may create multiple accounts with the same name

to connect from different hosts,

Standard

localhost

For the standard password andfor host based authenti

select ‘Standard',

% and _ wildcards may be used

I PR e R e

I Type a password to reset it,

Consider using a password with & or more characters with mixed case letters, numbers and punct

I ]

I Enker password again ko confirnn,

Once you have done so, change to the “Schema Privileges” tab and click “Add Entry...” to select a

Figure 26 - Specifying user credentials of the new database user.

schema you want the new user to be privileged to perform some actions on.

i Users and Privileges

User Accounts

Details for account eusurveyuser@localhost

User Fram Hosk
{17 <anonymous o
ELSUPYEYUSEr localhost
rook localhost
roak 127,001
roak il

| Login | Account Limits | Administrative Roles | Schema Privieges

Schema Privileges

<

L}

Schema and Host Fields may use % and _ wildcards,
The server will match specific entries before wildcarded ones.

Delete Entry

In the modal dialog that appears, select “Selected schema:” and highlight the name of the schema you
created in a previous step. Then click “OK” to confirm your selection.

Figure 27 - Select database schema for privileged access.
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Mewnr Scherna Privilege Definition E@

Select the Schema For which the user 'newuser’ will have the privileges wvou want to define,

Schema
0 Ay Schema () This rule will apply to any scherma name,
i This rule will apply ta schemas that match the given name ar pattern,
() schemas matching pattern or name: You may use _ and % as wildcards in a pattern,
: Escape these characters with Y in case wou want their literal value,

meysgl
performancel_schema
sakila
test
waorld

@ Selected schema: Select a specific schema name For the rule o apply ko,

Figure 28 - Select schema from list.

Make sure that the name of the schema is highlighted correctly when it is selected. Otherwise, the
application will just not take the selection into account and will return without showing any error but
without having any schema selected, neither.

Once you have done so, you will be asked to specify the privileges to be assigned to the current user for
the selected schema.

From the tab labelled “Administrative Roles”, please set the “EVENT” privilege for this user.

1 Users and Privileges
Details for account eusurveyuygr@localhost

User Accounts

User From Host Login | Account Limits | Sdministrative Roles | Schema Privileges
{17 <anonymous =
ELs) WUISEF Role Description Global Privileges
rook lacalhost [7] cea grants the rights to perform all kasks [] aLTER
root 127.0.0.1 []  Maintenanceadmin grants rights needed to maintain server [] ALTER ROUTINE
root il ] Processadmin rights needed to assess, monitor, and kill any [] crEaTE
[ useradmin grants rights to create users logins and reset p: [C] CREATE ROUTINE
[ securityadmin rights ko manage logins and grant and revoke [T] CREATE TABLESPACE
[ Manitaradmin minimum set of rights needed to monitor server [] CREATE TEMPCRARY TABLES
[C] ©DBManager grants Full rights on all databases [C] crREATE USER
[ ©EDesigner rights to create and reverse engineer any dat [ crREATE vIEW
[]  Replicationadmin tights needed to setup and manage replication [] DELETE
[ Backupadrin rrimimal rights needed to backup any database [ prop
Custarm cuskom role EVENT
[T EXECUTE
[ FIE

Figure 29 - Grant EVENT administrative privilege.
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Then, from the tab labelled “Schema Privilege”, click “Select ALL” to assign all available privileges to the

new user you are about to create.

Finally, click “Apply” to create your new database user.

i Users and Privileges

User Accounts

Details for account eusurveyuser@localhost @

[Logn [ Account Limits | Admiristrative Roles | Schema Privieges |

ook nl

4

Object Rights

SELECT
INSERT
UPDATE
DELETE
EXECUTE
SHOW YIEW

4 [}

ALTER, ALTER ROUTIME, CREATE, CREATE ROUTINE, CREATE TEMPORARY TABLES, CREATE WIEW

User Fram Hosk
(1} =anonymous = Yo
ELSUIMVEYLSEE localhost Schema Privileges
rook localhiost EUsUrvEY
rook 127.0.0.1

Schema and Host fields may use % and _ wildcards.,
The server will match specific entries before wildcarded ones.

The user 'susurveyuser'@localhost’ will have the Following access rights to the schema 'susurvey':

1 3

Delete Entry ] [ Add Entry...

DDL Rights Other Rights
CREATE [T GRANT OPTION
ALTER CREATE TEMPORARY TABLES
REFEREMCES LOCK TABLES
INDEY

CREATE YIEW
CREATE ROUTINE
ALTER, ROUTIME
DROP

TRIGGER

[ Unselect Al ] [ select "aLL" {

Rewvoke All Privileges ] [Expire Password ] [Revert ] [Apply ] [ReFresh ]

Figure 30 - Grant full Schema Privileges.

4. Build the application

A web application is usually deployed by loading a so-called WAR file (“Web Archive”) into a respective
Servlet Container (or Application Server). Such a file contains already compiled Java classes as well as

human readable configuration files and more.

The next section will explain how to set-up a development environment and how to create an EUSurvey
WAR file from its sources. The advanced reader who is not interested in building-up a whole
development environment might be interested in the EUSurvey Deployment Guide that explains the
manual configuration of an existing WAR file to be deployed on a working environment.

To build the application from its sources, the following steps will have to be performed:

1. Download the EUSurvey sources from JOINUP webpage.
2. Load the sources into a new Java project using the Sprint Tool Suite.

3. Configure the application to match your environment.
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4. Export the WAR archive from the IDE.
5. Deploy the application on your Servlet Container.

The result of these steps will be a running EUSurvey application on your system environment.

Get the sources

Please get the EUSurvey source package as a zip archive from the location mentioned below and extract
the content of the archive to a folder of your choice:

https://joinup.ec.europa.eu/software/eusurvey

Create a new Project

Once you have extracted the EUSurvey source code to your hard disk, load it into your IDE for
configuration (and modification).

To do so, start the Spring Tool Suite you have installed in a previous step.

At start-up, you are asked to select a workspace. A workspace is a specific folder the system will save all
project relevant data to. If you are unsure about what a workspace could be good for, just stay with the
default.

Click “OK” to proceed with the program launch.

r Workspace Launcher @

Select a workspace

Spring Tool Suite stores wour projects in a folder called a workspace,
Choose aworkspace folder to use for this sessian,

Wéorkspace:; C:HLlsers‘-Lpeter‘-Lwnrkspacel - Browse...

Use this as the default and do not ask again

(0]4 l | Cancel

To create a new Java project from the sources, select “File->New-> Java Project” from the application
menu.

In the dialog, use “eusurvey” as the new project’s name and uncheck the “use default location”
checkbox.
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Then, click the button labelled “Browse...” to specify the folder you extracted the EUSurvey sources to.

f: Mewr Java Project = @

Create a Java Project

Create a Java project in the workspace or in an external location,

Project name: | eusurvey

@Jse default location
Location:  Cihsrcheusureey 1.1.5_oss

IRE
(@ Use an execution enviranment JRE: lawasE-1.7
Use a project specific JRE: jdk1.7.0_67
Use default IRE (currently 'jdk1, 1.0_6T" Configure IREs..

Project layout

Usze project folder as root for sources and class files

(@) Create separate folders for sources and class files Configure default..,

Waorking sets
[T12add project to warking sets

Select..,

(i) The wizard will automatically configure the JRE and the project layout based on the
existing source,

@ = Back Mext = ] [ Finish ] ’ Cancel

Figure 32 - Setting-up the project to import.

Then, click finish to create the project.
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Once you have imported your new project successfully, the IDE will start setting-up the project
environment. Most important, the integrated built-system named “Maven” will now start downloading
dependencies during the first build which can take quite some time.

Please proceed to the next step “Configure the application”, if the build-process succeeds without any
errors. Otherwise, please read below.

Troubleshoot

In case your computer is located behind a network proxy and you have never used Maven before, you
might run into trouble, given that Maven requires an internet connection to download missing packages
from the internet. In this case, Maven needs to be configured to use correct proxy settings to access the
internet. This is done by editing the Maven configuration file manually. The Maven built-system stores
its settings in a file named “settings.xml”, that is usually located in the folder named “.m2” in every
user’s home directory.

Organisieren * In Biblicthek aufnehmen + Freigeben fdr « Meuer Ordner
| Administrator it MName . Enderungsdaturm Typ
: :::liel | repository 07.05.2014 13:33 Dateiordner
B dost _ settings.xml <::: 03.03.2014 09:54 XML-Datei

Figure 33 - Browse to the Maven configuration directory.

Editing this file, please add or adjust the section named “proxies” and enter valid proxy settings as
depicted in the screenshot below

Example

<?xml version="1.0" encoding="UTF-8"72>
<settings =si:schemalocation="http://maven-apache.org/SETTINGS/1.0.0 http://maven.apache.org/xsd/settings-1.0.0.xsq"
xzmlns="http://maven.apache .org/SETTINGS/1.0.0"
xmlns:xsi="http://www.-w3.9rg/2001/XMLSchema-instance">
<proxies>
<proxy>
<activextrue</active>
<host>proxy.myhest.de</host>
<port>8080</port>
<nonProxyHosts>* . myhost.del|logalhost</nonProxyHosts>
</proxy>
</proxies>
<mirrors>

<mirror>

Figure 34 - Add proxy settings to Maven configuration.
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Once you have adjusted these settings, restart the package download for dependent libraries by
selecting “Maven->Update Project...” from your project’s context menu.

Please wait until the system has correctly downloaded the missing libraries before proceeding.

C lava - Dashboard - Spring Tool Suite
File Edit Source FRefactor Mawigate Search Project  Bun Window  Help
i OIS O Qe BB GO A B e e
Quick fccess
[£ Package Explorer 2 = 8 @. Dashboard 52 =
. T e 3
4 [|=2 eusu
Go Into
o B s
> [ sr Cpenin Mew Window
> & st Open Type Hierarchy F4
B Show In Alt+Shift -+ GUIDES Rele FORUM
. = IR
oL M [ Copy Crl+C
28 e .
E5 Copy Qualified Marme
= s
. Bt 5 Paste Ctrl+4
M pg ¥ Delete Delete
Rernowve from Contesxt Ctrl +Alt+ Shift+ D own M2 Released
. b release of Spring Security 4.0.0.M2 Get Started!
Build Path ¥ Etone repository. SpringOne 2GX 2014 is
Source Alt+Shift+5 »  irplace at SpringOne in Dallas, TX for Sept
Refactor Alt+Shift+T
g2y Import.. Hin Spring Security 3.2.5 and
3 Export.
& ige kog) and 3.1.7 (change log) hawe been
Qe’ Rt P n Maven Central. Important highlights of
Close Project ke contains a fix for CVE-2014-3527 ... Rob
Close Unrelated Projects
Assigh Working Sets.. Add Dependency
Add Plugin
Peiilla 2 i’ @ Mewy Maven Module Project
Cebug Az 3
Ruun A3 5 Download Javaloc
\alidate Download Sources
3 .
Team IR Update Project..,
Compare With 4 Enable Workspace Resolution -
Restore from Local Histan., Disable Wforkspace Resolution R
E> Mawven 3 Disable hawen Mature
Java EE Taols 3
Aspect] Tools 3

Hint

Figure 35 - Update a Maven project from project's context menu.

Just in case this does not solve the error, it might be necessary to rebuild the project. To do so, please
make sure that “Build Automatically” is selected in the Project menu of the application and click “Project
->Clean...” to clean and rebuild your project.
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(. Java - eusurveyssrc/main/fwebapp/AVER-INF/spring.properties - Spring Tool Suite EI@
File Edit Source Refactor Mavigate Search Bun  Window Help

o= H R0 BE - N PR AR Open Project SRk - . '| o
Close Project Quick Mocess E:f| & Spring
% Package Explorer % = 8 BRI Gk hibernate.cfg.... [Z] spring.properties 22 = O B Task List 52 = B8
Build Project
& - g = o | =
= i % 6 i
T s Build Working Set ¥ ernate.cfg.Mysql. oss.aml - he
i
Clean...
v Build Automatically mysgl. jdbe. Driver Find S0 b Al P Activa..
alhost/eusurwey?characterEncoding=UTF -8
£ Generate Javadaoc..,
Properties

# Web progy, ConTiguration [1n case your server has no direct internst connec

Configure the application

Important information for users who already used previous versions of EUSurvey: With this new
version 1.3.4 you have the possibility to deploy the application on two different servers. Please carefully
read the instructions below; they differ from the previous installation.

This is like the previous release of EUSurvey; the application runs on one server (user interface,
background tasks, statistics, etc.)

This is a new feature, where the main server will execute almost all tasks (user interface, handling of
HTTP sessions, etc.) while the worker server instance will serve to execute CPU- and memory-
consuming tasks like exports, calculations of statistics, survey archiving and restoring, etc.

The settings of the application are still located on the spring.properties file, but now you will find two
different spring.properties files. Both of them are located under the src/main/config. In this folder you
will find two sub-folders “main” and “worker” that contain the adequate configuration file.

To configure the application to match your system environment, open the file named
“spring.properties” from the same directory and configure the application to match your environment
settings. This includes the following properties:

e Database settings (use the settings for the MYSQL user you configured earlier)

e Application server settings (Optional)

e  Proxy settings (Optional, needed if your network is behind a proxy sever)

e System folder settings ((Optional)

e SMTP server configuration (Optional, needed if you want to send out invitations).
e Worker server configurations

Below you will find a short overview of all the possible settings in the spring.properties files:

Important: Depending on the selected server mode (main or both servers), you will have to update the
corresponding spring.properties file (two files if you use the worker mode).
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SMTP settings
Specify a working SMTP configuration to enable self-registration of new users.

e smtp.server - The configure SMTP server used
e smtp.port - The respective port the SMTP server is running on
e smtp.sender - The email address used by the application for sending email from

Directory settings

Specify directories to be used by the application. Defaults are valid for installations on Windows system
only. Please adjust these settings if running the application on a Unix environment.

e export.fileDir - Directory used to save uploaded and system generated files (e.g. uploaded files
and results of web service tasks).

e export.tempFileDir - Directory used by the system to save temporary data (e.g. where PDFs and
other exports are created)

Proxy configuration settings

Specify how the application will connect to the internet, if you are running the application behind a web-
proxy and you do not have direct internet connection.

e proxy.host - The host running your web-proxy

e proxy.port - The port running the proxy

e proxy.user - The privileged user being allowed to pass the proxy

e proxy.password - Above mentioned user's password

e proxy.nonProxyHosts- If you need to bypass some address such as localhost to avoid error

Server settings
Global configuration of the application:

e server.prefix - Server prefix used for absolute links (e.g. for loopback calls). Port settings must
match the settings of your servlet container (default is "http://localhost:8080/eusurvey", if
unset)

e pdfserver.prefix - Server prefix of the local server instance that will provide survey content for
being translated to PDF. Improves performance when a reverse proxy mapping is used. Should
be set to the same value as server.prefix, otherwise

Server settings when using only the main server
In this case you only have to configure the spring.properties below /src/main/config/main

e isworkerserver - Must be set to false
e useworkerserver - Must be set to false (tell that we want to use only one server)
e workerserverurl — Must be empty

Server settings when using both servers (main and worker)
Settings for the main spring.properties
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e isworkerserver - Must be set to false

e useworkerserver - Must be set to true

e workerserverurl —set the url path of the worker server such as
http://myworkerserver:8080/eusurvey

Settings for the worker spring.properties

e isworkerserver - Must be set to true (tell that the current instance is the worker server)

e useworkerserver - Must be set to true

o workerserverurl — set the url path of of the current server (must point to itself) such as
http://myworkerserver:8080/eusurvey

The following settings are optional:
Resource settings

e export.xsllink - Location of the style-sheet used to visualize translations in XML format (URL)
e export.poolsize - Number of instances in the three pools use to perform asynchronous
operations (exports, PDFs, web services)

Connection pooling (c3p0)

Configuration of the connection pooling system for Hibernate is best described at
http://www.mchange.com/projects/c3p0/

Special settings
Settings that are useful in special situations only:

e stresstest.createdata - Setting this to 1 creates a lot of dummy data usually used for stress-
testing an environment

e webservice.maxrequestsperday - Limits the number of web-service calls per user to that
many

e app.server.env - Creates a banner in the upper left corner used on dedicated environments.

e Publicsurveynotification -Used to setup the mail address(es) of groups/persons
(administrators) that must be contacted when you want to create a public survey (available
for everybody)

e ui.enableresponsive - set this value to true if you expected the usage of differents device for
the answering of your surveys (see release note) By Default this property is set to false

e ui.enablearchiving - allow the archiving of old surveys by setting this property to true, by
default the value is false (see release note). WARNING by enabling this feature you can have
a negative impact on the performance

e ui.enablefilemanagement - this property allows the management of files generated by the
application (export,...) under the configuration section of EUSurvey (you should be an admin
to get this feature). By default the value is set to true. For more explanation about this
feature please refer to the release note.
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Possible values are acceptance/stress/test or development

# database properties

app.jdbc.driverClassName=com.mysql. jdbc.Driver
app.jdbc.url=jdbc:mysql://localhest/eusuryey?characterEncoding=UTF-8
app.jdbc.username=gusuryveyuser

app.jdbc. password=smétdGjdsd

# web proxy configuration (in case your server has no direct jinternet connection)
proxy.host=your. proxy.com

proxy . port=8881

proxy.user=usernams

proxy.password=password

# export configuration
export.tempFileDir=C:/temp/
export.fileDir=C:/temp/files/
export.poolsize=2

server.prefix=http://server:port/eusurvey/
export.xsllink=http://server:port/eusurvey/resources/xsl/eusurvey.xsl
pdfserver.prefix=http://server:port/eusurvey/

# mail configuration
smtpserver=smtp.server.com
smtp.port=25
sender=infofimyServer.com

Figure 37: Configure the spring,properties file.

Automatic translation

If you want to use the translation tools, see after the chapter concerning the automatic translation (see

prerequisites)

# if false use Microsoft translation otherwise European Commission machine translation
mt.use.ec.mt=false

# If you want use MST translation for your survey you have to register

# to the Microsoft Translator data service, please refer to the 055 installation guide
microsoft.translation.client.id=your account here
microsoft.translaticon.client.secret=your secret phrase here

After successful modification, save your changes back to the WAR file you have edited.

Hint

Please notice that the system needs to be configured to connect to a working SMTP server to be able to
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send out email invitations for secured surveys. Please make sure the configured connection allows
emails to be sent, before making this feature available to your users.

Human verification and Captcha
The application has, by default, included a captcha verification system from Google. If you do not want
this kind of verification or if you do not have access to the web, you can disable this option.

To disable it on the spring.properties file, search for the property captcha.bypass and set the value to
"true".

If you want to use the recaptcha system, you need a Google account. In order to get this, go to the
Google website https://www.google.com/recaptcha/intro/invisible.html

e Select "Get reCAPTCHA"

Get reCAPTCHA

e Create your account (or log in with your Google account) and follow the instructions
e You will receive a captcha key and secret. Then, you have to update in the spring.properties
file(s) the properties "captcha.key" and "captcha.secret"

List of public surveys - configuring mail to accept or decline public surveys

As administrator, you have to accept or decline surveys that are declared as public. As soon as they are
accepted, the surveys will be available in EUSurvey's "Public list of Surveys".

EUSurvey has a dialog box to send e-mails to the survey managers in telling them that their survey has
been accepted or denied. In this dialog box, you can configure two fields: "Reply to" and the signature.

For "Reply to", this has to be done through the spring.properties, by setting the sender property. For the
Signature field, go to /src/main/webapp/WEB-INF/views/administration/publicsurveys.jsp. On this
page, search for this statement below and replace the hidden type signatureValue with the appropriate

value.

<c:choose>
<c:when test="${oss} ">
<input type="hidden" value="${sender}" id="replyToValue'/>
<input type="hidden" value="Your team" id="signatureValue'"/>
</c:when>
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Accept

*Reply [0
|DIGIT-EUSURVEY-SUPPORT @ec europa.eu |

* Subject

‘Your publication request for the EUSurvey Homepage ‘

*Text

B 7 ¥ & = =L o
FontSizes ~ A ~ FontFamiy -~
Dear Jean-christophe GUELFI, A

Your request for publishing your survey in the list of all public surveys has been
accepted.

To see vour guestionnaire in the list. please follow this link:

*Signature
B /I YU s = E £ o
Font Sizes ~ A ~ FontFamily ~

Your EUSurvey Team A

Cancel

Data Collection and Privacy Best Practices

In terms of data protection you are responsible for the data that is stored on your EUSurvey instance. It
is therefore highly recommended to disclose your privacy practices to your users by providing a privacy
statement for EUSurvey. By default EUSurvey oss is delivered without any privacy stataments.

If you want to enable those privacy statement you MUST set in the spring.properties file the property
show.privacy=true.

If you enable this privacy, every user will have to accept your terms when logging in for the first time
before being able to use the application.

By default, the OSS release has an empty privacy statement page. If you want to configure this page to
publish your own privacy statement, you have to edit the file called tos.jsp that you can find on the
WEB-INF/views/auth path. To be sure to have the text in the right place the, on this tos.jsp page search
the "<!-- SET HERE THE ENGLISH TEXT OF YOUR PRIVACY STATEMENT -->", the "<!-- SET HERE THE
GERMAN TEXT OF YOUR PRIVACY STATEMENT -->" and the "<!-- SET HERE THE FRENCH TEXT OF YOUR
PRIVACY STATEMENT -->" and write just after your own privacy statement text.

By default the statement exist for the English the German and the French language.

With this privacy statement, you inform your users on how you are handling data in EUSurvey. It should
detail at least the following things:

e Anintroduction referring to the privacy or data protection rules of your country (legislation
may differ from country to country!)

e Why are you collecting data

e Who is responsible for the processing of the data
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¢ What personal information you are collecting

e To whom your data is disclosed

e For how long you are keeping the information in the database

¢ What are the contact points for questions, complaints and recourse

Many organizations are themselves regulated by data privacy laws and regulations, as well as internal
policies. You should ensure that you are familiar with these, as you will be responsible for ensuring that
your EUSurvey instance complies with these requirements.

For further information you may also wish to consult the website about data protection rules in the EU.

Create the WAR archive

Once you have correctly configured your application, you can compile the application and export a WAR
file for deployment on the Servlet Container.

To do so, we will use the Maven tool, first exit from your IDE.
Locate where you have extracted the source code, and open a command prompt to this location.

Hint: to be sure of the execution you have to open the command prompt in the folder where the
pom.xml file is present.

Warning: due to the multiple configuration (main and worker server) you MUST use the profile maven
setting

Type the following execution line: mvn clean package —Pmain/worker. It will execute the following:

e Aclean-up of old previous compiled files that are remaining

e Check if there is no error at the compile time

e Execute the creation of the WAR file

e The —P will execute the war by getting all files that are located under the
src/main/config/[main|worker] (spring.properties,...)

If this execution is successful, the generated WAR file will be present on the target subfolder
Hint:

e If you need to create the war file only for the main server then launch the
mvn clean package —Pmain line = it will generate the war by including all files located below the
src/main/config/main folder and subfolder

e If you need to create the war file only for the worker server then launch the
mvn clean package —Pworker line = it will generate the war by including all files located below
the src/main/config/main folder and subfolder

e You cannot generate at once the main and the worker server war file, you need to compile first
the main, copy the generated war file to the destination location and then generate the worker
server war.
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Ex.: if you saved your sources file to c:\eusurvey the war file will be located below c:\eusurvey\target

folder.

Warning

Make sure the name of the exported file is really “eusurvey.war”, given that this name is crucial for
conducting self-referenced calls to the application. The application will not work if deployed under a

different name.

The WAR file you have just exported basically contains the configured application that can be deployed

on an arbitrary web-container of your choice to run the application.

5. Deploy the application

Now that the application has been configured correctly, it is ready for deployment on a Servlet

Container for execution.

To deploy a web-application, one of the easiest ways is to copy the WAR file to a folder the application

server will check regularly for new applications to deploy.

For Apache Tomcat, this folder is called “webapps” and is located in the server’s folder under “Program
Files”. To deploy the application, just copy the WAR archive you exported in a previous step to the

application server’s “webapps” folder.

@ l\_JI v| ‘W \Program Files nache Software Foundation\Tomcat 7.00webapps
Organize = Include in library = Share with = MNew folder
3 Documents m Marme Date modified
rJ”- hdusic
o . docs 18.08.2014 13:40
t
§ V'; Hres  manager 18,08.2014 13:40
ideos
. ROOT 18.08.2014 13:40
T aeeen tar

Type

File folder
File folder
File folder

Figure 38 - Copy the application to the auto-deploy directory of Tomcat.
As soon as the server has been started, open the root URL of EUSurvey that is:

http://localhost:8080/eusurvey

Please notice that on first access, the application will start creating the database structure and will do

some initial configuration work. This might take a couple of minutes.

As soon as the application has finished the system initialization, the browser will show the application’s

welcome page:
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EUSurvey  Aapa

/
\V cUSurvey

Create online surveys

and raise your forms to the next level

Dinling surviys msde ey with EUSunvey? Hive pou ivir niadad ¢

Pgiatar Ko

Figure 39 - The application's welcome screen.
Troubleshoot
In case the web-page is not displayed, please make sure Tomcat has been started from the System

Service view.

6. Importing Language Table

After the first deployment, the application only supports three different languages: English, French and
German. In order to add more languages, you will have to import the “is0639-1.xls” file, contained in the
source data.

You can find this file at this location within your unzipped source data:
src/main/webapp/WEB-INF/Content

If you open the file, you will see a table with 186 languages, their native writing, the official language
code and a fourth column (column D). All languages marked with a “1” in column D will be imported.
Initially, all EU languages are marked to be imported. You can add/remove languages to be imported by
simply adding/removing a “1” in column D.

To actually import the data (admins only), you will have to open the following URL:
[SERVER]/eusurvey/administration/languages

Select the file and then click “Import”.
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3 |Avestan avesta AE
4 |Afrikaans Afrikaans AF
5 |Akan Akan AK
6 |Amharic ATRCE AM
7 |Aragonese aragonés AN
8 |Arabic I AR
9 |Assamese e As
10 |Avaric asap mauyl, marlapyn mauyl AV
11 |Aymara aymar aru AY
12 |Azerbaijani azarbaycan dili AZ
13 |Bashkir GawkopT Tene BA
14_ Belarusian Benapycran MoBa BE
15 |Bulgarian Grarapckn esuk BG
16 |Bihari Aol BH
17 |Bislama Bislama Bl
18 |Bambara bamanankan BM
1‘3: Bengali e BN
20 |Tibetan i35 BO
21 |Breton brezhoneg BR
22_ Bosnian bosanski jezik BS
23 | Catalan; Valencian catala, valencia CcA
24 |Chechen HOXYWIAH MOTT CE
25 |Chamorro Chamoru CH
26 |Carsican corsu, lingua corsa co
27 |Cree ol AFTA CR
28 |Czech testina, tesky jazyk cs
29 |0ld Church Slavonic W3EIKE CNOBEHECKE cu
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31_We|5h Cymraeg cyY
32 |Danish dansk DA
33 |German Deutsch CE
34 | Divehi; Dhivehi; Maldivian; 22 DV
35 Dzongkha == DZ
36_ Ewe Eveghe EE
37 |Greek ehhnvikd EL
38 |English English EN
39 |Esperanto Esperanto EQ
40 |Spanish espafiol ES
41_ Estonian eesti, eesti keel ET
42 |Basque euskara, euskera EU
43 |Persian FA
44 |Fula; Fulah; Pulaar; Pular Fulfulde, Pulaar, Pular FF
45 |Finnish suomi, suomen kieli Fl
46 |Fijian vosa Vakaviti Fl
47 |Faroese faroyskt FO
0 48_ French francais, langue francaise FR
E 43 |Western Frisian Frysk FY
50 |Irish Gaeilge GA
51 |Scottish Gaelic; Gaelic Gaidhlig GD
52 |Galician galego GL
53 |Guarani Avafie'd GN
5| ati 2121l Gl
i« » is0639-1 Sheet2

Figure 40 - Preview of language list



7. First Steps on EUSurvey
Once you have successfully deployed the application on your own application server, you are ready to
either run or modify your own instance of EUSurvey.

Depending on what is planned to do next, the interested reader is referred to the following
documentation:

e The Quick Start Guide - for creating a survey right away (for Survey Managers)

e The Help pages - for advanced information on how to create surveys (for Survey Managers)

o The Developers Guide - for technical details of the application and basic information on how to
interact with the provided IDE (for Developers)

e The EUSurvey community forum on JOINUP

User Management
The system has a default admin account to let you manage your users. The default username and
password of this account are “admin” (username) and “admin” (password).

To be able to create new users, enter the Administration area of EUSurvey, via the little gear-wheel icon
in the top right corner of the blue banner

Hello Admin (logout) | About I Support | Download | Documentation ﬂ

Figure 41 - Enter the administration area

There you will find a category called “User management” from where you can create new users and give
them rights. In order to add a new User, click on the “Add User” button and fill out the requested
information.

o) < -~ 2 .
‘ @Welcome 2, Dashboard /;/) Surveys 1 Exports h( Address Book P Settings
Search || Reset Configure
U sers ’ ? \
L] € User1Totof1 » L]
User Management Login +4 Email 44  Language Roles Comment Actions
Role Management ®
System Management dummy All values ~ All values ~
dummy dummy@company.org BG Applicant A dummy user PR

Rows per Page 10

Figure 42 - Add new system user to the application
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